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Disclaimer of Warranty

THIS SOFTWARE AND ALL ACCOMPANYING FILES ARE DISTRIBUTED "AS IS" 
AND WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR 
ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.

Because of the various hardware and software environments in which CSetup/Setup may be 
used, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure demands that any program be thoroughly tested with non-
critical data before relying on it. The user must assume the entire risk of using these 
programs. 

ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT OR REFUND OF PURCHASE PRICE.

Benefits of registering the CSetup Package

CSetup and Setup have both been released into the public domain as 'SOURCEWARE'. 
They can be used at NO COST for installations of UP TO twenty-five (25) copies. If your 
product will exceed this limit, you MUST register to have ANY legal rights to use them. This 
means that a small company distributing twenty-five (25) copies or less of any ONE product 
has NO LEGAL requirement to register.

The benefits to registering are two-fold. Not only will you legally be free to use this 
package an unlimited number of times, you will also receive the complete 'MS C/C++ 
SOURCE CODE' for BOTH programs. This means you will be able to modify the code to 
produce a Setup routine unique to YOUR company and product. Anyone considering using 
these programs should seriously consider REGISTERING!
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Introduction

Thank you for trying the CSetup package.  These products are intended to be used by any 
individual or company responsible for creating and distributing Microsoft Windows software. 
Over the past few years, we looked at several Setup programs and found them all lacking 
certain features unique to our installation needs. The more expensive programs were too 
difficult to learn and either offered no source code or priced it so high that it was not practical 
to acquire. The inexpensive programs lacked many features we desired and didn't offer any 
means of acquiring the source code. In the end, we created our own Setup program and have 
used it with great success. The only problem we still faced was the fact that the entire process 
of creating, testing and distributing software was split over many areas. The writing and 
testing of software were the areas we wanted to spend our productive time. Instead, we were 
spending too much time in the 'distribution' part of the process. The final release of our 
products, creating the Golden Master and end user diskettes, developing the installation 
routine, etc. (the distribution process) was taking too much time away from our development 
efforts. We decided to combine as many distribution steps as possible into one stand alone 
product. That product is the CSetup package you now have in your possession.

CSetup will fully automate the entire distribution process:  creating and verifying Setup 
script files, generating Golden Master Diskettes from the SETUP.INF file and mass 
duplicating distribution diskettes. All the Setup programs we looked at used script files to 
handle the installation process. Some of these scripts were so difficult to prepare that we 
immediately discarded the program. Others were too simple and offered no customization 
options. CSetup allows several different install options to be selected by the end user and 
makes the entire process of creating and testing script files almost effortless. The script file is 
not usable until it successfully passes the CSetup Test function. Testing verifies that every 
line of data entered by the developer is valid. CSetup will not allow creation of Golden Master 
Diskettes until successfully passing the test. CSetup then leads the developer through the 
process of making the Golden Masters, even prompting when its time to label and write-
protect them. The final step, creation of distribution diskettes, has never been easier. The 
Golden Masters are duplicated effortlessly and verified to make sure all diskettes created are 
error free. A running count is kept so the developer always knows how many copies have been 
made. To make more copies later, simply run CSetup again using the same Golden Master 
Diskettes, duplicating as many additional copies as required.

At last, a complete software distribution process that is easy to use and powerful too!
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1.0 - Getting Started

CSetup is easily installed into Windows using the Setup program:

1.  Insert the Setup diskette in Drive A (or B if required).

2. Using Windows File Manager, access the  File menu and select Run.

3. Enter  A:SETUP (or B:SETUP if required) and click the OK button.

4. The SETUP program will start and you will answer several questions.

5. Based on your answers, the software will be installed on your fixed disk.

6. A new Program Manager Group will be created, and several icons added to it.

7. The SETUP program will confirm its successful completion, and you are done.

8. Double click the CSetup icon in the newly created Program Group to begin.

9. Use the Help menu in CSetup for instructions on getting started.

  10. Read the rest of this Users Manual for more complete instructions.

NOTE:  If you downloaded CSetup from a bulletin board system, the Setup diskette
(Step 1 above) has been replaced by the CSETUP.ZIP file. In this case, you must first
create a directory on your fixed disk called CSETZIP and copy the file you downloaded
into it. Then uncompress the CSETUP.ZIP file in the CSETZIP directory and change
Step 1 above to read:  

Enter C\:CSETZIP\SETUP and click the OK button.

6



2.0 - Operating Procedures

The following steps are required for successful installation of your software:

1. Create the SETUP.INF script file.

2. Test SETUP.INF to make sure it is valid.

3. Run SETUP.INF using the Setup program to further test it.

4. Generate GOLDEN MASTER DISKETTES.

5. Mass duplicate the GOLDEN MASTERS.

Each of these steps will be explained in detail now.

2.1 - Create the SETUP.INF script file

The SETUP.INF script file is the brains of the Setup process. It directs the Setup program 
with all the steps required to successfully install your software. Most Setup programs force 
you to use some form of line editor to prepare this file. The only testing they allow is the final 
one using the actual Setup program. Much time is wasted going back and forth between the 
editor and the Setup program. CSetup changes all this. Built into CSetup is the editor you will 
use. When you access the New option on the File Menu, a shell script file is loaded. This shell 
contains only required sections. The developer simply fills in data for their current project. 
The sections to be filled in are:

STARTUP
DISKS
DIRS
OPTIONS

The STARTUP section contains four (4) parts:

1.  AppName - The name of your current application (maximum of  40 characters).
For example: Setup Program

2.  Options - A numerical value from 1 to 3 setting how many options the user will see.
3.  DefDir - The directory on the users hard disk where your software will be installed.

For example: C:\SETUP
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4.  DefPMGroup - The Program Manager Group from which your program will be run 
followed by a comma and a title. The title can have a maximum of 30 characters.

For example: TEST.GRP, Test.

The DISKS section contains at least one (1) line, up to a maximum of  ten (10) lines.
Disk 1 example:  1=Setup Disk
Disk 2 example:  2=Data Disk

The first line must be present and should be filled in with the name of your first diskette. A 
maximum of  50 characters can be used.

For each additional diskette, add one (1) to the previous line number and fill in the name of 
the next diskette.

Continue until a maximum of ten (10) lines have been entered.

The DIRS section contains at least one (1) line, up to a maximum of thirty (30) lines.
Line 1 example:  1=.
Line 2 example:  2=DATA
Line 3 example:  3=DOCS

The first line must be present and must be a period (.). This signifies the default directory for
your installation. A maximum of eight (8) characters can be used.

For each additional sub-directory under the root, add one (1) to the previous line number 
and fill in the sub-directory name.

Continue until a maximum of thirty (30) lines have been entered.

TIP:  The directory structure you enter must contain the actual files you will be installing. 
Make sure your fixed disk has the same directory structure with copies of all the required 

files!
If SETUP.INF says a file is compressed, make sure to compress it using the Microsoft 

Compression Program (COMPRESS.EXE) supplied with the CSetup package. The correct 
usage for compressing files is:  COMPRESS -R  filename.ext.  SETUP.INF would than use 

the name  filename.ex_  and a Y in the FILES section below would indicate a compressed file.

The OPTIONS section contains three (3) sub-sections:  OPTION1, OPTION2 and OPTION3. 
Each of the sub-sections contains two (2) additional sections, FILES and PM INFO. You can 
fill in all three sections, if required, or just ignore those sections you won't need. Be aware 
that the 'Options=' section in STARTUP decides how many options will be displayed to your 
end user. Just because you fill in every Option with valid data doesn't mean the end user will 
see it. If the STARTUP section only contains a 2, that is all the options the end user will see. 
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Each OPTION used must be given a Name and the estimated Size of the files to be installed 
(in thousands, 500,000 would be entered as 500). The Name can have a maximum of 80 
characters.  The Size should include any additional space needed by your program.

Example of OPTION1:  Main Program, 1000
Example of OPTION2:  Upgrade Only, 300

NOTE:  The Setup Program will display a dialog box to your end users allowing them to 
choose which OPTIONS to install only if you use more than one (1) option.

Each OPTION that you use must have the FILES and PM INFO sections filled in as follows:

The FILES section contains a name to be displayed (maximum of 40 characters), the actual 
file name to be installed, the disk to be used, the directory to install the file into and whether 
or not the file is compressed (Y=Compressed, N=Not Compressed). The disk to be used must 
be a valid disk number from the DISKS section. The directory to install the file into must be a 
valid directory number from the DIRS section.

For example:  Setup Program, SETUP.EXE, 1, 1, N

The PM INFO section contains the Program Manager Icons to be created. The actual file 
name comes first. This must be a valid name from the FILES section or some other program 
you know will exist on the end users hard disk (NOTEPAD.EXE for example). The next part 
is the name to be displayed under the Icon created by Program Manager. It must be a 
maximum of 30 characters. These Icons will be placed into the DefPMGroup you specified in 
the STARTUP section.

For example:  SETUP.EXE, Setup

2.2 - Test the SETUP.INF script file

The SETUP.INF script file must successfully pass the Test function before the other 
CSetup options become available. As you fill in the script file, you can test immediately to 
make sure everything is valid. A final test should be made when the script file is completed. If 
every part passes, you will be able to access the next options. If any part fails, go back and 
revise it so that a successful test can be achieved. Be aware that the test process can't possibly 
check for all possible situations. It does check to make sure all required sections exist and that 
data was entered in the correct places. Many other checks are also made to validate the data 
entered. It is much better to find out now that something doesn't work rather than waiting until 
the Setup program bombs! Refer to section 3.41 for additional details regarding Testing the 
script file.

2.3 - Run SETUP.INF using the Setup program

The SETUP.INF file should be further tested in the live Setup environment. Just because 
it passes the CSetup test function doesn't mean it really works as expected. Watch carefully as 
the installation process takes place. Make sure every file goes into the right directory. Run 
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each application created in the Program Manager Group. Do they all run as expected? Be 
aware that the setup process will go much faster during this test because all files are being 
loaded from your hard disk. In a real user installation, files will be loaded from a floppy 
diskette which will slow the process down. You might have to run the Setup test several times 
to uncover bugs or inconsistencies. Refer to section 3.42 for additional details regarding 
running the Setup program.

2.4 - Generate GOLDEN MASTER DISKETTES

The GOLDEN MASTER DISKETTES are the key to the whole distribution process. 
They will contain the final release version of your product. They will serve as the Master 
Copy all other copies will be made from. You could just keep making Master Diskettes each 
time an end user set is required, but this would be very dangerous. What if something 
changed since the time you made the Master. The new copies would not be the same as the 
last set. The only way to insure that every copy is an exact duplicate of the original is to use 
the original as the source of all copies. CSetup automatically copies the Setup Program, 
SETUP.INF and all necessary DLL files to the first Master Diskette in the set. Refer to 
section 3.43 for additional details regarding the GOLDEN MASTER DISKETTE process and 
a helpful tip.

2.5 - Mass duplicate the GOLDEN MASTERS

Duplication of the GOLDEN MASTERS is the lifeblood of the distribution process. The 
copies you make will be delivered to your customers. Nothing can be more embarrassing than 
having an irate customer inform you a diskette is defective. A good duplication process should 
verify that every copy made is in perfect working order. Obviously, damage could occur 
during shipping and handling. You should at least feel confident the diskettes left your 
location in perfect condition. CSetup will give you that confidence! Refer to section 3.44 for 
additional details regarding the duplication process.
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3.0 - Description of CSetup menu options

CSetup contains five (5) main menu options.

1. File

2. Edit

3. Search

4. Utility

5. Help

Each of these main menu options will be explained in detail now.

3.1 - File

The File menu option is a standard Windows menu option with the following sub-options:

3.11 - New

Loads the shell SETUP.INF file to start a new installation project. The shell has all the 
major sections required by the Setup program but none of the data specific to any actual 
installation. It is up to the developer to fill in the missing pieces and Test to make sure 
everything works. This option will display a message if current data has been changed but not 
yet saved, warning you to save the data. If you choose not to save them, changes made during 
the current session will be lost!

3.12 - Open

Displays the Open File Dialog Box where you can load previous SETUP.INF files into 
CSetup for use or revision. This option will display a message if current data has been 
changed but not yet saved, warning you to save the data . If you choose not to save them, 
changes made during the current session will be lost!

3.13 - Save

Saves the current SETUP.INF data to your hard disk. Make sure to save all data that you 
fill in and successfully test.
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3.14 - Save As

Displays the Save As File Dialog Box where you can change the file name of the current 
SETUP.INF data file.  During normal use, this option should not be required. However, if for 
some reason you want to change the name (test purposes for example), this menu choice will 
let you.

3.15 - Print

Displays the Print Dialog Box where you can print the current SETUP.INF on paper. Print 
it out as often as you want. You should definitely print it when it is completed so that you 
have a permanent record. 

3.16 - Print Setup

Selects a printer and sets printer options for CSetup before printing. The available options 
depend on the printer you select. 

3.17 - Exit

Quits the CSetup program and returns to Windows. This option will display a message if 
current data has been changed but not yet saved, warning you to save the data before leaving. 
If you choose not to save them, changes made during the current session will be lost!

3.2 - Edit

The Edit menu option is a standard Windows menu option with the following sub-options:

3.21 - Undo

Undoes your last editing or formatting action, including cut and paste actions. If an action 
cannot be undone, Undo appears dimmed on the Edit menu. 

3.22 - Cut

Deletes text from SETUP.INF and places it onto the Clipboard, replacing the previous 
Clipboard contents. 

3.23 - Copy

Copies text from SETUP.INF onto the Clipboard, leaving the original intact and replacing 
the previous Clipboard contents. 

12



3.24 - Paste

Pastes a copy of the Clipboard contents at the insertion point or replaces selected text in 
SETUP.INF. 

3.25 - Delete

Deletes selected text from SETUP.INF, but does not place the text onto the Clipboard. 
Use Delete when you want to delete text from the current SETUP.INF but you have text on 
the Clipboard that you want to keep. 

3.3 - Search

The Search  menu option is a used by CSetup to handle the following options:

3.31 - Find

Opens the Find Dialog Box to allow searching for characters or words in SETUP.INF. 

3.32 - Next

Repeats the last search without opening the Find Dialog Box. 

3.33 - Replace

Finds all reference to the current search and replaces it with new characters or words 
specified in the Replace Dialog Box.

3.4 - Utility

The Utility menu option is used by CSetup to handle the following options:

3.41 - Test Current Data

Tests every line in the current SETUP.INF file to make sure all data entered is valid. If it 
finds an error, a messagebox is displayed showing the error and the section it occurred in. The 
CSetup options 'Run Setup Program' and 'Create Master Diskette' cannot be accessed until the 
current SETUP.INF file is error free. This option should be used often during the SETUP.INF 
creation process to make sure everything works.
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3.42 - Run Setup Program

This option runs the actual end user Setup Program to install your product. It is a very 
good idea to test your SETUP.INF file in a live environment before assuming it works 
correctly. Just because SETUP.INF passes the CSetup test routine does not mean it actually 
works as it should. The developer should try it using Setup and watch to make sure it actually 
performs as expected.

3.43 - Create Master Diskette

This option allows the developer to create the diskettes that will contain the final release 
version of the current project. The Master Diskettes are the culmination of all the time and 
effort spent developing a product. They should be treated like gold, hence the name GOLDEN 
MASTER DISKETTES. CSetup uses the SETUP.INF data to make these diskettes. You can 
be sure that if your SETUP.INF passes the CSetup test and the live Setup test, the Master 
Diskettes will work. To be safe, you should also test the Master Diskettes from an end user 
point of view. Once you are sure they are 'Golden', the duplication process can begin.

TIP:  The Master Diskette process will inform you when the currrent diskette has been 
filled up. Initially, set ALL files to use the first disk and CSetup will let you know when the 
next one is required. Then, simply modify the appropriate SETUP.INF [FILES] section, and 
begin the Master process again (using a new blank formatted diskette). It could take several 
passes to create the final Golden Masters, but this is much easier than trying to manually 
calculate how many files will fit on each diskette!

3.44 - Duplicate Master Diskette

This option allows the mass duplication of the GOLDEN MASTER DISKETTES. The 
most important part of the development process is the end user diskettes. Many developers 
feel this is so important that they send their Master Diskettes out to a third party for 
duplication. Obviously, if you are going to be making thousands of copies, it is better to use a 
third party. By the same token, if you are making that many copies, you are probably using 
one of the expensive Setup programs. The labels alone make it more economical to use a third 
party if your volume is that great. The average developer will find it easier and less costly to 
duplicate the Masters themselves. CSetup allows you to read in a Master once, and copy it out 
as many times as required. CSetup will even verify that the tracks written back out are 
correct. This validation process is very important so you can be confident your diskettes are 
error free. They are if they pass the CSetup verification process! To be safe, you should never 
use a diskette that fails verification. Later, you can try to re-format the diskette,  using it only 
it if formats error free. CSetup keeps a running count of the number of copies made of each 
Master Diskette in any one session. If you need to make more copies later, simply run CSetup 
again and use the Master Diskettes to make additional copies.
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3.5 - Help

The Help menu option is a standard Windows menu option with the following sub-options:

3.51 - Introduction

This option displays the Introduction Box that is shown when you first start the CSetup 
program.

3.52 - Using CSetup

This option displays context sensitive help depending on the part of CSetup you are 
using.  It can also be accessed by pressing F1 or the Help Toolbar icon.

3.53 - Keyboard Shortcuts

This option displays the keyboard shortcut commands that can speed up your use of the 
CSetup program. The Toolbar Icons can also make using the program easier.

3.54 - Helpful Hints

This option offers some helpful hints and tips to make using the program a little bit easier 
for a first time user. It will also give a guided tour of a typical developers use of CSetup.

3.55 - Why Register

This option offers potential users of CSetup several reasons for registering.

3.56 - Register Now

This option explains how to register the CSetup package. See Section 6.1 of this Users 
Manual for an order form.

3.57 - Users Manual

This option accesses the Users Manual you are now reading.

3.58 - About CSetup

This option displays the About Dialog Box which shows the version number and other 
information about the CSetup program.
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4.0 - Hints and Tips for successful installations

This section will give a guided tour of a typical developer using CSetup. The X-Ray-Z 
Company, a developer of Windows game software, has been working on a new game for 
several months.. They hope to release the game, X-Ray-Trazer, in a few weeks. They recently 
acquired the CSetup Package and are ready to try it out. They install it in the default directory, 
C:\CSETUP, and read some of the help screens. It looks promising, and they decide to create a 
test directory for their game and the CSetup files. They create a new directory called 
CSETXRAY and copy the executable files from their game directory into it. Then they copy 
over the files from the CSETUP directory, and run CSetup. They choose NEW from the FILE 
menu, and the shell script file appears. The first thing they do is set AppName to "X-Ray-
Trazer Game". They leave Options set to 1 and make the default directory "C:\TRAZER". 
They name the DefPMGroup "Trazer" and press the Test Icon. An error message immediately 
appears stating "PM Group title not found". They press F1 for help, and see that the PM 
Group needs a Name and a Title. Not sure how this should be entered, they access the on-line 
Users Manual and find instructions for creating the SETUP.INF script file in section 2.1. An 
example is given for each section and the DefPMGroup example shows a Group Name 
followed by a comma and a Group Title. They add the extension ".GRP" to the data entered 
before, and then a comma and the title "Trazer". They press the Test Icon, and an error 
message appears stating "Illegal number of files to copy". They realize no files have been 
entered under OPTION1, and type in "TRAZER.EXE", the executable name of their game. 
Another error message appears when they press Test, and they decide to follow the User 
Manual instructions for the rest of the data entry. They add the File section data for diskette 
number, directory and compression. They also add a Name for OPTION1 and the estimated 
size needed to install and run their game. The next time they press Test, a message box says 
"Test successfully completed". It also says the following options are now available:

1. Add more information and Test again.
2. Run the actual Setup process to verify it. 
3. Create the final Golden Master Diskettes.

They have more files to be copied, and they enter them also. They fill in the Program 
Manager information section and Test again. Everything tests successful and they are feeling 
more and more confident. Their SETUP.INF file now looks like:

; SETUP INFORMATION FILE
; v1.5 Format

[STARTUP] 
AppName=X-Ray-Trazer Game
Options=1
DefDir=C:\TRAZER
DefPMGroup=TRAZER.GRP, Trazer
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[DISKS] 
1=Disk 1

[DIRS] 
1=.

[OPTION1]
Main Program, 1000

[FILES] 
Trazer Program, TRAZER.EXE, 1, 1, N
Trazer Help File, TRAZER.HLP, 1, 1, N
Trazer Data File, TRAZER1.DAT, 1, 1, N
Trazer Data File, TRAZER2.DAT, 1, 1, N
Dynamic Link File, TRAZER.DLL, 1, 1, N

[PM INFO] 
TRAZER.EXE,  Trazer Game

[OPTION2]

[FILES]

[PM INFO]

[OPTION3]

[FILES]

[PM INFO]

[END]
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At this point, they decide to test the script file in a live Setup environment and press the 
Setup Icon. A message comes up saying they are about to run the Setup Program and to make 
sure and use a new directory path. They press OK and the Setup Program begins. They like 
what they see so far, and press Install to begin the process. They expect to see their 'Main 
Program' Option appear, and are surprised when they go directly to the Directory Path Dialog 
Box. They press Exit to quit the Setup Program and are told "The Setup Process was not 
completed". They check the Users Manual again to try and find out what happened to their 
OPTION1. They discover that the user is only shown an Options Dialog Box if more than one 
option is available. In their case, only one option exists, so it is automatically accepted by the 
Setup Program. Their confidence in the process restored, they again press the Setup Icon. 
When the Directory Path Dialog Box appears, they enter a new path name (C:\TRAZER1) 
and press Continue to begin the installation process. They watch as the files they previously 
entered in SETUP.INF are copied. Then Program Manager starts, and a new Group is created 
with an  Icon called 'Trazer Game'. A message appears telling them "Setup successfully 
completed" and they click OK. They double click the 'Trazer Game Icon', and their new game 
starts. They play it for a few minutes and then exit out. The CSetup program appears again, 
just as they left it. The entire process took about fifteen minutes, not counting the time they 
spent playing X-Ray-Trazer!

They are impressed with what they have seen so far, and decide to create a Master 
Diskette to see what it will look like. They press the Master Icon and a dialog box opens, 
informing them that a set of Master Diskettes is about to be created from the SETUP.INF file. 
This is one of the processes they usually dread. It takes too much time to create Master 
Diskettes, and usually three or four tries to get it right. They are prompted to insert a blank 
formatted diskette, which they do. Unfortunately, the diskette they insert is write-protected, 
and CSetup informs them to insert a different diskette. They fix the problem and CSetup 
creates a Master Diskette. They put a label on it when CSetup tells them to and write-protect 
it. Curious as to the contents of the diskette, they can't wait to test it to make sure it works. 

They quit CSetup and try installing their game from the new Master Diskette. They run 
Setup from the floppy diskette, and the installation goes flawlessly. They decide to make some 
duplicate copies, so they can test the installation process on several other machines. They start 
CSetup again, and use the Copydisk Icon to make two user copies. The first one is easily 
completed. The second one fails the verification process, telling them to insert a different 
diskette, which they do. The second copy is now completed with no problem. A message tells 
them to try re-formatting the defective diskette later, and use it only if it formats with no 
errors. They make a note and set it aside. They make one more copy with no problem. Now 
they wonder, will the user diskettes just made really work?

They exit out of CSetup and install their game on three different machines, using a 
different diskette each time. All three machines run the game with no problem. They try 
formatting the defective diskette and find out that it has 30K of bad sectors. If these sectors 
had been used to hold their game, problems would have occurred. CSetup passed their tests 
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with flying colors. The only thing they really didn't like was the Setup program displaying the 
X-O-LEN Technology bitmap. It would be much better to have their X-Ray-Z logo and name 
displayed for customers to see. When they realize the source code can be purchased, enabling 
them to re-compile with their own bitmap, they immediately send in the registration fee. 
When their CSetup package arrives, they change the bitmap and make a personalized Setup 
program that still works with CSetup. They immediately think of a few changes their Setup 
program should have, and write down the changes they want. Once their new game is 
released, they will have time to work on it. For now, the Setup Program with their bitmap will 
handle user installations just fine.

Thank you CSetup!  It really was as advertised, a complete software distribution process, 
easy to use and powerful too!
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5.0 - Glossary

Compressed - The process of shrinking files to take up less diskette space. CSetup 
can automatically uncompress (expand) them if you tell SETUP.INF they are compressed.

Copydisk - The function used to duplicate Master Diskettes.

CSetup Program - A complete development system for creating, testing and implementing 
installation routines for Windows software.

Distribution - The process of duplicating, verifying and releasing software.

Duplication - Copying Master Diskettes to create end user copies.

End User - The recipient of your software, your customers.

Expand - The process of expanding compressed files to back to their original size. The Setup 
program uses the LZEXPAND functions to handle this process.

Golden Master Diskette - The final release version of your software. Used to make the 
distribution diskettes.

Icons - Picture buttons that perform a task when clicked.

Installation - The process of setting up software on the end users hard disk. Copies files from 
floppy diskette and creates Program Manager Groups and accessible Icons.

Main Menu - The second line at the top of the Windows screen listing the Main options of 
the program. Access it with the mouse or by pressing the Alt key and the underscored 
character. The Main Menu will usually present a drop down menu with additional options.

Master Diskette - See Golden Master Diskette

Options Dialog Box - The box that appears in the Setup Program if more than one (1) option 
exits. Allows users to select the parts of your software to install.

Program Manager - The Windows shell program. Presents an easy to use front end to the 
Windows environment. Groups of Icons allow easy access to installed software.

Register - The process of acquiring the rights to use computer software. All registered users 
of CSetup will also receive the complete source code.

Script File - The data file used by the Setup program to control the installation process.
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Setup Program - A program that installs software onto an end users hard disk. Usually has an 
associated Script file that controls the process.

SETUP.INF - The Script file used by a Setup program. Contains instructions for installing 
software on a hard disk.

Shell - A blank SETUP.INF Script file. All the required sections are present, but none of the 
actual data.

Shortcut Key - A keystroke or set of keystrokes that automates a task. Used to perform 
several steps with one action.

Source Code - The data files that make up a program. Includes all necessary make files, batch 
files, bitmaps, icons, etc. needed to re-compile the program. 

Sourceware - The method of distribution for CSetup. Unlike Shareware, Sourceware is FREE 
up to a certain number of uses. If the usage limit will be exceeded, you must register. The 
process of registering Sourceware also gets the purchaser the complete source code for the 
product.

Test - CSetup function that verifies a script file contains valid data.

Toolbar - A set of Icons, usually located below the Main Menu, that perform specific tasks 
when clicked. They work like shortcut keys only are easier to remember because they contain 
pictures and brief descriptions.

Verification - The process of making sure something works as expected.

Windows - The operating environment CSetup works under. Microsoft Corporation created 
this Graphical User Interface (GUI) environment to make computers easier to use.
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6.0 - Registration Instructions

Registration is simple.  Send a check or money order in the amount of $50.00 to:

Mark A. Trent
6 Angeline Court
Fairfield, New Jersey  07004-1506  (USA)

Payment MUST be in US dollars drawn on a US bank or you can send international 
postal money orders in US dollars.  Once your payment is received, a diskette containing the 
complete source code (Microsoft C/C++ only) will be mailed to you.  You will also receive 
written authorization to use both products on an unlimited basis and rights to modify ALL the 
source code.

Make sure to enclose your COMPLETE return address so we can deliver your package 
without delay!
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6.1 - Order Form

CSetup Order Form

Enclosed you will find ___ Check  ___ Money Order (check one only) in the amount of $50.00 

(US Dollars) covering registration fee for the CSetup package. In return, I will receive a license 
to 

use the CSetup package an unlimited number of times and a diskette containing the complete 

source code.

Please send the source code on  ___ 3.5" Diskette  ___ 5.25" Diskette (check one only).

Send my CSetup package to:

NAME _____________________________________________

COMPANY _____________________________________________

STREET _____________________________________________

CITY _____________________________________________

STATE                                         ______________________

ZIP CODE                                   ______________________

Additional instructions or comments:  

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

Send this order form and payment to:

Mark A. Trent
6 Angeline Court
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Fairfield, New Jersey  07004-1506  (USA)
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